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Office 2010 Features, and New Menu Bars (Ribbons)

As you read through this document you will notice the Ribbon concepts can be
used in all the Office Ribbons, not just within Word.

Word

Ribbon — Different tabs when clicked, displays a new ribbon. When you select table, pictures
or other items, different tabs appear at the top of the ribbon.

|E| = A= MS Word 2010 Features.docx [Compatibility Mode] - Microsoft Word = B ER
Home Insert Page Layout References Mailings Review View Developer Add-Ins [ e
Y o menewron -l & 4| Ac (B == F R80T [ampcal aabeet AaBbC aasbee | A o
Paf'-E v; @ I U -abe x, X° e - é' = ~ Q' fe & T Normal | T Mo Spaci.. Headingl Heading2 |- Eg:;gf :SE\Ed'
ipboard Font Paragraph Styles Fl Editing
—- H I
File Tab e I
. . H Save
Select the File Tab and you’ll see Options toward the bottom of the drop
down. Click Options and Word Options will open up. Save As
Lj Open
Lj Close
Recent
- Mew
Options where users can
customize save capabilities, Print
change the color scheme of the
interface, adjust auto corrections Save & Send
and other options.
Help
:] Options
Ed Exit
Page 1
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Word Options

21|

Word Options- - !
Click each item on the Frooting

left side of the < e

. Advanced
WIndOW and neW Customize
options will appear.

Add-Ins

Trust Center

\ Resources

L_& Change the maost popular options in Word.

Top options for working with Word

72 Show Mini Toolbar on selection i

¥ Enable Live Preview

=2 Show Developer tab in the Ribbon

2 Always use ClearType

= Open e-mail attachments in Full Screen Reading view

Color scheme: |B|LIE vl

SecreenTip style: IShnwaaturE descriptions in ScreenTips j

Personalize your copy of Microsoft Office

User name: IStaff
Initials: IS
Choose the languages you want to use with Microsoft Office: Language Settings... |

[ 1|

Cancel

Fd

Word Options

2|

Popular

Display

_ Proofing

Click on Proofing dvanced

Customize

Add-Ins

Look at the settings y
under AutoCorrect >

Options.

ancl
|_7/5‘ Change how Ward corrects and formats your text.

AutoCorrect options

Change how Word corrects and formats text as you typg

AutoCarrect Options... |

When correcting spelling in Microsof

v [gnore Internet and file addresses

~ Flag repeated words

| Enforce accented uppercase in French
r Sugagest from main dictionary only

Custom Dictionaries... |

French modes: ITraditiDnaI and new spellings j

‘When correcting spelling and grammar in Word

¥ check spelling as you type

W use contextual spelling

W mark grammar errars as you type
¥ Check grammar with spelling

™ Show readability statistics

Writing Style: IGrammarOnIy 'I Settings.., |
Recheck Document |

Fﬂ] M5 Word 2007 Mew Features.dooe j

Exceptions for:

™ Hide spelling errors in this document anly

| Hide grammar errors in this document anly

[ oc ]

Cancel
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You will find items on
AutoCorrect, AutoFormat,
Math AutoCorrect, Smart
Tags and AutoFormat As
You Type

AutoCorrect: English (U.5.) 2=

AutaFormat

AutoCorrect | Makh AutoCorrect I AukoFormat As You Type

V¥ Show AutoCorrect Options butkons

| Smark Tags

V¥ Correck Twio TMitial CApitals

Iv¥ Capitalize First letter of sentences
I¥ Capitalize firsk letker of table cells
[V Capitalize names of days

[¥ Carrect accidental usage of caPS LOCK key

Exceptions. .. |

—Fﬂeplace text as yvou bype
Replace: with: € Plain ket

" Formatted ket

[V automatically use suggestions From the speling checker

Add | Delete |

Ik I Cancel |
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Quick Access Toolbar- d2-00WUAFITEFHAQ

On the left pane within Word Options, click Customize, and you will be presented with two
columns of options: the left has every addable function available for the program (which can be
organized by Popular Commands, Commands Not in the Ribbon, and All Commands), and the
right contains what functions have been added to the Quick Access Toolbar. Simply add and
remove as you see convenient for your needs. This toolbar sits next to the Office button, but you
can move it below the ribbon by choosing that option while customizing.

Format Toolbar- When you select an image you get a different tab and ribbon

Ly wm s w
Home Insert Page Layout References Mailings Review View Developer Add-Ins Format [ e
i “"’ i 3] i - = [l
* G Corrections » 4 — — — e— p— 2 Picture Border = ﬂ ﬂ J_] Bring Forward .I'f. _"J_. ;‘J 077 .
’ %Color' g’; d d d ﬂ # = | ! Picture Effects = _\h Send Backward = ] f
Remove + e - Position Wrap . Crop =1 33- »
Background || Artistic Effects ~ QE - - < Text~ ik - =
Adjust Picture Styles Arrange Size
. N . -
If you select a picture you’ll see a different Tab called Picture Tools as well as Format
= R B RE Documentl - Micrasoft Word Picture Toals. — & 52
Home Insert Page Layout References Mailings Review View Developer Add-Ins Format [ e
i % Corrections = :3{ — — — — I Picture Border ~ ﬂ ﬂ 5 .|;'-' 4\[;l- éJ e -
= Oy Color - By il |ondll| ol ol ol - PicturcEifeds - & I 4
Remove . | m o Position Wrap ® . s Crop 51 6.5° :
Background | Artistic Effects - QE = | %2 Picture Layout ~ - Text = Cily Selection Pane kT -
Adjust Picture Styles . Arrange Size

Remember to select the picture to see the Picture Toolbar displayed

Line Spacing- there is an automatic line space after a return for a paragraph that can be turned
on and off. Click on the line spacing button/ or select this St{le for No Spaces.

Word o B

@ .!‘ ) ~ J ¥ M5 Word 2010 Features oo [Compatibility Mode] - Microsod
[nsm Page Layout References Mailings Review View Developer Add-Ins o @
== iy 1| e= = I . 3 Find ~
| Times New Rom - 14 -~ - B =ei=eh iFiE A % +
H) g |[Tmeshew AX A | =2 FE T ABLC | AggpCd AaBbC AaBbCc r
“ac
Pa'ste ” B|Z U - e x aby . A- EEF 3~ [H - TMormal | TMoSpaci.. Headingl Heading2 gzal:]f s Select -

Clipboard Ia Font . Paragraph . ‘ Styles . Editing

You can set as default by opening the Paragraph window. Double click on Paragraph button.

Choose settings and Click button for “Set As Default”
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Note the default line spacing is 1.15  » He
v | 115
1.5
20
2.5

This menu will display, you can choose to add/or remove the 3.4
space before or after a paragraph Line Spacing Options...

\

Add Space Before Paragraph

<M U<

Add Space After Paragraph

Page Laygut- Click on the bottom right of some areas in the ribbons to display more options.

) ISNgUd 2007 Mew Features.docx - Microsoft Word -TXx
(Oa _
y Home Insert Mailings Reviem View Developer Acrobat @

ﬂ Watermark = Indent Spacing 4 Bring to Front = Align =

j nv J 'y Orientation ~ ',%B NG
WL v Ij Size = £ Line

Nobers - || ¥ Page Color~ | EE Left: 0 - [TV S<gefore: 0 pt s d3 Sendto Back - [#] Group
Themes Margins __ o . = " Position .
- ' - £= Columns ~ be~ Hyphenat! g Fage Borders | E% Right: 07 ¥ || p= After: - ﬂTe-t Nrapping Sl Rotate
Themes Page Setup Page Background Paragraph = Arrange

do-0003FSEYEHA =

Indents and Spacing I Line and Page Breaks |

Page Setup 21x|

Margins | Paper I Layaut I

General

Margins
H = O = Alignment: m
Top: lﬁ Bottom: lﬁ
Left: 1" E‘ Right: Id E‘ outling level: |Body Text -
Gukter: m @utker position: m

Orientation

Indenkation

Left: " 5‘ Special: Bryt

Bight: IU" = I(none) j | =

I™ tirror indents

Portralt  Landscape

Pages
. ‘ Sparing
Multiple pages: INorma -
Before: 0 pt 5‘ Line spacing: Atk
After: fiopt =] [Mutigle = s
Preview

™ Don't add space between paragraphs of the same style

Preview

Apply ta: |Whole document VI
Default... Cancel Tabs... Default... | [o]4 I Cancel
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Insert from Scanner and Camera- Open
Microsoft Office Document Scanning in the
Microsoft Office/Microsoft Office Tools folder

Digital Certificate For YEA Projects
|_§| Microsoft Clip Organizer
ﬁ Microsoft Office Document Irmaging

Choose your scanner

w [Microsoft Office Document Scanning

Micrasaft CFFid

Microsoft CiFFid

Scan mulkiple page documents
documents by using Microsoft ©

Microsoft Office Diagnostics

Or from the Clip Art Organizer

Click on Insert Tab

th_ﬂ\ M5 Word 2007 Mew Features.dooc - Microsoft Word
9 Home @ Page Layout References Mailings Review View Developer Acrobat
€] Cover Page - Elg ’-[_jJ zj ii lg)Hmerlink =L j j A =] Quick Parts ~ |2 Signature Line - JT Equation ~
Y — = = =
1 Blank Page = = A Bookmark = = = A wordart - [3 Date & Time €2 symbol ~
= Table Clip |Shapes Smartart Chart Header Footer Page Text - .
b=, Page Break - Art - ] Cross-reference - +  Mumber~ | Box+ == DropCap Fge Object
Pages Tables Hlustrations Links Header & Footer Text Symbols
Y- 00U B=EEYHE 0
Click on Clip Art Click on Organize clips... Clip Art v x
Search for:
drama
Search in:
. . R R Al collections -
Click on File and choose Add Clips to Organizer S ——
Selected media file tvpes -

E Favorites - Microsoft Clip Organizer

File igdit Wiew Tools Help
[ Mew Callection...

Add Clips to Organizer Automatically. ..

=] % On My Own, ..
) @ Frorn Scanner of Camera.. .

K Exit

T
ﬁ Office Collections
(-5 web Callections

Choose From Scanner or Camera
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03) Clip art on Office Cnline
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To Insert a Header and Footer make a selection from the Insert ribbon-

."-_ﬁ'\_ IS Word 2007 New Features.docx - Microsoft Word -
_Ey Home @ Page Layout References Mailings i View Developer Acrobat
] Cover Page ~ j . ElEl Lr‘}) zj a 3_99 Hyperlink :'___ L - A 2| Quick Parts = |2 Signature Line ~ || TT Equation ~
all Kbl 1 = n = = # d

©

_] Blank Page A Bookmark WordArt ~ jE)Date & Time £2 symbol =
= Table Picture Clip Shapes SmartArt Chart Hed Footer  Page Text .
+= Page Break - Art - '#] Cross-reference - Number~ || Box~ Z£= Drop Cap b Object -

Pages Tables Mustrations Links Header & Footer Text Symbols

H9- 00D R=EeEv 0 -

Header & Footer Tools ribbon will display

D_ N M5 Ward 2007 New Features,docx - Microsoft Word Header & Footer Tools -
(B
fy Home Insert Page Layout References Mailings Review View Developer Acrobat Design (7]
j j j = J ElE] j Previous Section Different First Page iu Header from Top: 0.5 s
= 5 " CI™T = <l s
- = X S/ = = - » Mext Section Different Odd & Even Pages || [zd Footer from Bottom: |0.5° - —
Header Footer  Page Date Quick Picture Clip Goto t X Close Header
- +  Mumber~ || &Time Pagy~ Art r % Link to Previous V| Show Document Text 5] Insert Alignment Tab and Footer
Header & Footer Insert Mavigation Options Position Close

HY-COUL3SF I -

Click on Quick Parts drop down to bring up a

menu to insert your filename in your footer or | | Document Property P
header. Click on Field..: —r .
I Q Building BElotcks Crganizer... :

%2  Get More on Office Online... |

_,h Save Selection to Quick Part Gallery...

Note the Checkbox for Add path to filename

Please choose afield ——— | Field properties Figld options
Cakeqgories: Farrnat: *IV

(Al ~| [ - |
I J Uppercase

Field names: Lawercase

Cikation d First capital

Comments Title case

Corpare
Createlate
Database
Dhate
DocProperty

Dochariable LI
EditTime

Ei

FileSize:

Fill-in

GoTaoButton

Greetingline

Hevperlink,

If

IncludePicture ﬂ

[¥ Preserve Formatting during updates

Description:
The document's name and location

Field Codes | [ol'd I Cancel
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Special add on feature for saving a document as a PDF we installed

Save As to PDF-

Save a copy of the document

Click on Save As from the Office Button to liw j Word Document
. . Save the file as a Word Document.
display this menu. Choose Adobe PDF.

EF.‘ Word Template

Save the document as a template that can
ke used to farmat future documents.,

@ j Waord 37-2003 Document

Save a copy of the document that is fully
compatible with Waord 97-2003,

\.| Adobe PDF

OpenDocument Text

Save the document inthe Open Document
Farmat,

A

PDF or XPS

Publish a copy of the document as a PO'F or

If you save as a Web Page XTML file, note that ublis
XPS file.

a folder will be created as well as a file. So if you
. Other Formats
delete the folder you also need to delete the file L _
Open the Save As dialog box to select from
that was created. all possible file types.

Z

Mini-Toolbar- (shown below) comes up when you Right Click where you are typing or
Select text. You will notice the menu comes up dull in appearance; but move your mouse over
the area and it becomes fully viewable. (You cannot change the buttons on this toolbar)

Times New - |12 - A" A" A

B I =E¥-A-EEi=-
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Math Tools

Click on the Insert tab in the ribbon and then select the Equation drop down

'/E-'_‘:! MS Waord 2007 New Features.docx - Microsoft Word -aXx
| =
- o Home @ Page Layout References Mailings Review View Developer Acrobat (7]
|£) Cover Page ~ Ellg] LE'P % Hyperlink =k o I |Z| Quick Parts = [ Signature Line ~ | JT Equation ~
Sl 2:5 = = =
|} Blank Page kel 4 Bookmark = = s < wordart - [S} Date & Time £2 symbol -
= Table Picture Clip Shapes SmartArt Chart Header Footer  Page Text —
= Page Break - Art - ['#4 Cross-reference - *  Number~ || Box+ £=Drop Cap b3 Object -
Pages Tables Tustrations Links Header & Footer Text Symbols
d2-000A@E5ETHA0 -
./t;; M5 Word 2007 Mew Features.docx - Microsoft Word Equation Tools -TXx
A5 B
- = Home Insert Page Layout References Mailings Review Wiew Developer Acrobat Design @)
€3 Professional X X n X = . Ay i 10
e FIEIETECIEOEEY ¥ €54 [0 & o § Im A
€3 Linear = y X -X =0 {( )} a n+0o 01
Equation N E = Fraction Script Radical Integral  Large Bracket Function Accent Limitand Operator Matrix
- abe Mormal Text i - - - - Operator~ - - Log~ - -
Toals E] symbols Structures

If you select the Equation Button,

you will find a number of built in

(Cn

=)
~9/  Mome

equations to choose from.

Intert

If you click the button to the right of Tools area,
you will bring up the Equation Options window.

r General

Default font for math regions: M

¥ automatically convert expressions to professional format

[” Reduce size of nested fractions in display equations
When copying an equation,

" Copy MathML to the dipboard as plain text

' Copy Linear Format to the clipboard as plain text

Break lines with binary and relational operataors: IBeﬁ:re - |
Duplicate operators for subtraction &5; I - = I

Math AutoCorrect... | Recognized Functions. .. |

~ Display Math
When building up integrals,
% Place integral limits to the side
" Place integral limits centered above and below
When building up other n-ary operataors,
" Place n-ary limits to the side
{* Place n-ary limits directly above and below
¥ Use the following settings for math on its own line,
Left Margin: II:I' E‘ Right Margin: ID' 3‘
Math margins are added to paragraph marginz.
Justification: ICentered as group j

For math that wraps to a new line;

¢ Indent wrapped lines by: |1' 3‘

" Right align wrapped lines

Defaults ... | QK I

Cancel
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Mail Merge- click the Mailings tab

(Bla Qvord 2007 New Features.door - Microsoft Word -gXx
[ st =
a Home Insert Page Layout References @ Review View Developer Acrobat @

8 1 = 1, = P Rules {aeCh \ 1 9 | | Lol | "
L = w! : - =5 ) I i =
e ; :

JJHat(h Fields <z Find Redipient
Envelopes Labels || Start Mail  Select Edit Highlight ~Address Greeting Insert Merge Preview | ° Finish & || Merge to
Merge~ Recipients * Recipient List || Merge Fields Block Line Field 2] Update Labels || pesylts | S Auto Check for Errors || perge Adobe PDF

Create \ Start Mail Merge ‘Write & Insert Fields Preview Results Finish Acrobat

AN
Click on Start Mail Merge drop down to display this menu

Letters

E-Mail Messages
Envelopes...

Labels...

Directory

Mormal Word Document

Step by Step Mail Merge Wizard... Step by Step Mail Merge Wizard... works like Word 2003

FEODDLDw

Tables- Notice two different tabs, Design and Layout- click tab to select the Ribbon needed

Da MS Word 2007 Mew Features.doce - Microsoft Ward - X
[t p
o Home Insert Page Layout References Mailings Review View Layout @
Header Row First Column | [/  loomo—— —— ——— @ @ 3
Total Row Last Column ===l == == Y pt .| =
- 1L " === _ Draw Eraser
V| Banded Rows [¥] Banded Columns = o PenColor~  Taple
Table Style Options Table Styles Draw Borders fa
'/E"".l MS Word 2007 Mew Features.docx - Microsoft Word lable lools - X
G
> Home Insert Page Layout References Mailings Review View Developer Acrobat Design @

lg Select ~ >( ﬁ ﬁ Insert Below || [ZH Merge Cells -;Id 0.88° s .:I_,I_ S=EE A= B Al v Repeat Header Rows

[ view Gridlines HE Insert Left i Is ,__'__,‘ s 'I{ s=2=5 — Z =& Convert to Text
Delete | Insert Text Cell Sort

B properties - Above B Insert Right i AutoFit ¥ =l = I pirection Margins Je Formula

Table Rows & Columns P, Cell Size [F} Alignment Data

== Split Table
Merge

N———

To split one table into two tables, you must do the following:
Select the row that you want to be the first row of the second table.
Under Table Tools, on the Layout tab, in the Merge group, click Split Table.
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Select All

Control A still selects the entire document or Click on the Select Button from the Home Ribbon

M5 Word 2007 Mew Features.doo - Microsoft Word

—
(Ca
: >® nsert Page Layout References Mailings Review View Developer Acrobat
&4 Find ~

=X - A aml[EL] 2= - iz - =] [2E = (A
_j i Times Mew Roman 12 | A A || ‘{| = 0= = ’ér—l‘zl” bl | AaBbceDe|| AaBbceDe AaBbCi AaBbCc - Aa—
By ac
Paste 3 [B I U -abe x, x* Aa-||[®- A-[||= = §||$§v||év | THormal | T Mo Spaci.. Headingl  Heading2 = g:yalnge
- - s -

{F Styles (P

{Fi Paragraph

Clipboard ™= Font
CEMCEETECTE 2= T Ei_vﬂelectﬁll
. I
Click on Select All L Select Objects

Select Text with Similar Formatting

Rulers- click the icon to the far right
at the top of the slide bar

ind -

Live Preview- temporarily applies formatting on the selected text or object when you mouse-

over any of the formatting buttons. This temporary formatting is removed once the mouse
pointer is moved away from the button, allowing you to preview how the text would appear

without having to apply it.

M5 Word 2007 Mew Features.doox - Microsoft Word

Aailings Review View Developer Acrobat

-
(O
. o Home Insert Page Layout

Times Mew Roman |T| 12

U] | AsBbCel| ABbC AaBbC: AaBbe:

Sl T Mormal | T Mo Spaci.. Heading1 Heading &

NS

Theme Fonts - E
Cambria {Headings) %
Calibri (Body)

Paste

P
23
4

(F] Styles

Clipboard ™=

M Recently Used Fonts

@ % Times New Foman

% Tahoma

T ZeCianac

T AbcClacks f 2007 Hiew Features. dons - MicrasoNWerd

T W T En i silcedin
T Garamond

T AlenAbegria
All Fonts

T Al lbegria
T KbeFmfigndang

iy f?bc@m@ign@ong@*eﬁer
B AbcBullstin

T AbcClocks
7
Y. i 7 s Y. 7 P
T Fdeltinacase The foimmaliimg fuliome. ALl Tembeiaing folmmaliing
¢ 7 4 7 7

18BIE 18819 =

Design |, Layout |

2l LE

A R
Cel Sort

e Formula

Adrobat

[ 7 .
ML GRS LRPETL

o
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Drawing Toolbar- Click on the Insert Tab and click on Shapes, you will see a number of
new options to choose from.

@ dm9- MS Word 2007 New Features? - Microsoft Word - =
iaa)
Home Inser‘t Page Layout References Mailings Review View Add-Ins Acrobat @
@ Cover Page ~ E &Hyperlink Cl =1 b A— |§ Quick Parts ~ L& Signature Line ~ | JT Equation ~
HE s = = .
1 I |
|

|_] Blank Page Il A& Bookmark d‘WordAr‘t = @ Date & Time | £2 symbol
Table Plcture Clip |Shapes|SmartArt Chart | | Header Footer Page || Text
Box~ A5 Drop Cap~ ’gg Object ~

| =
b% Page Break H ‘
Text Symbaols

Art = || 't Cross-reference
1 Used Shapes L

';.\\DODAILI:)&Q,

K = Mumber ~
Header & Footer

Pages Tables

a~n{ Ty b Ao the feat woudd & geas without having to apply it.

Lines
SNNSNLTLL T RRNG G
Basic Shapes Page 11
BEOOUSCO®AMNOOD
UEDODOO@RA G
O8O0 1L 3

Block Arrows

2T RLLRIT
€ dwvnoDD D [BLIEMN
A

Flowchart
O0<-0OO00lS=0aY
CODONBE X 6§ AVED
QBOoO

Callouts
G@QQEEE@JAHQ
¢ 0 A0 A0 o

Stars and Banners

kA e G 8 g g dxnE 0
T ERIY

é New Drawing Canvas

CV Com)

A

Once you create a shape and have it selected a new Drawing Tools tab appears

[ Iﬂ Ly Rl ] )= MS Word 2007 New Features2 - Microsoft Word Drawing Tools =anX
toay | |
Home Insert Page Layout References Mailings Review View Add-Ins Acrobat Format
- it i & .
=~ NOodl- o K ) | 4 Bring to Front ~ |2 57 [0.28 =
. w9 -
crte- . W2 J cp%cp ysenatosac- (7
- B — Shadow Paosition . or|044 +
KIRTAS IS 45 = = @ | Effects~ I:L Effects‘ 5 - pETextWrapping - kv || ™2
Insert Shapes l Shape Styles £l Shadow Effects 3-D Effects J Arrange J Size I | |

Using the Shape Styles area button, you can open the Shape AutoFormat Window.
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Compare Word 2003 to Word 2007 with some tasks

Task

Word 2003

Word 2007

Change the document view:

1. Click View from the
toolbar.

2. Select preferred view from
the resulting menu.

[EEN

. Select the View tab
. Select preferred view from

Document Views group

Create a new blank
document:

[EEN

. Click File from the toolbar.
2. Select New from the
resulting window.

. Click the MS Office Button

and select New.

. Select New from the

resulting menu and click
the Create button.
(Control N)

Open an existing document:

[EEN

. Click File from the toolbar.
2. Select Open from the
resulting menu.

. Click the MS Office Button

and select Open.

. Navigate to existing

document and click the
Open button. (Control O)

Save a file:

1. Select File from the Menu
Bar.

2. Select Save from the
resulting menu.

. Click the MS Office Button

and select Save.
(Control S)

Save an existing document as

a new Word document or
file type:

1. Select File from the Menu
Bar.

2. Select Save As from the
resulting menu.

3. Navigate to location to save
file.

4. Enter the name for the new
file in the File name: box.
5. Click the Save button.

. Click the MS Office Button

and select Save As.

. Select the file format type

from the resulting menu.

. Navigate to location to save

file.

. Enter the name for the new

file in the File name: box.

. Click the Save button.

Use the Mini Toolbar to
modify text

Not available.

. Select the text you wish to

modify and direct pointer
to the Mini Toolbar above
the text selection.

. Click on the appropriate

formatting option

Format font:

1. Select the appropriate
formatting option from the
Formatting toolbar.

. Select the Home tab.
. Select the appropriate

formatting option from the
Font group
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Insert a bulleted or 1.

numbered list

Select the Bullets or
Numbering buttons from
the Formatting toolbar.

. Select the Home tab and

select one of the following
options from the Paragraph
group: Click the arrow on
the Bullets button to select
your bulleted list style, or
Click the arrow on the
Numbering button to select
your numbered list.

Insert a picture: 1.

Select Insert from the Menu
Bar.

. Select Picture from the

resulting menu

. Select From File from the

resulting menu.

. Navigate to the location

where the picture is
located.

[EEN

. Select the Insert tab.
. Click on Picture from the

Ilustrations group.

. Navigate to the location

where the picture is
located.
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Developer Ribbon

Place a check for Developer under Customize Ribbon section in Word Options

( Word Options )

(2 [t

Click OK and Developer

General @ . . . R
| Customize the Ribbon and keyboard shortcuts. R bb I I
ibbon will appear as a
LChoose commands from: (1 Customize the Ripbon: i
Procfing Popular Commands El Main Tabs El t b I t'
Sove ab selection.
@ Accept and Move to Next ~ Main Tabs
tanguage = Align Left T B [V] Home
A Ereaks 3 Clipboard
Bullets » Font
Customize Ribbon )] = Center Paragraph
“3- Change List Level 3 Styles
u aalbar 23 Copy L Editing
% cut 3 Ribbon Hero 2
Adddns Define New Number Format... Insert
Trust Center ") Delete Page Layout
4 DrawTable References
Draw Vertical Text Box Mamngs
i E-mail B SN
44 Find Py
Font i I D DE\IEIUpEr
A Font.. < Remove gl tdd o E ’
A Font Color » ® .Ammat
Font Size I- Blog Post
# Format Painter [7]insert (Blog Post)
A" Grow Font Outlining
& Hyperlink.. Background Removal
AB' Insert Footnote
Ié Line and Paragraph Spacing »
F Macros
[ Mew
—d MNew Comment
#1 Next New Tab New Group Rename..
i= Numbering Z

Keyboard shortcuts:

3
Customizations:
Import/Export ~

Developer Ribbon

Home Insert Page Layout References Mailings Review View Developer Add-Ins Acrobat
3 P Record Macro —| Aahfa |:| % Design Maode lj % schema 'E (w2 _o'ﬁ
E = o), =g =
Visual Macros . Add-Ins  COM Structure o Elock  Restrict | Document Document
Basic A Macro Security Add-Ins ﬁ J_ Eﬁ%’ % Group 4= Expansion Packs | suthors - Editing | Template  Panel
Code Add-Ins Contraols XML Protect Templates

Here is where you wil

| find the controls for Forms
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